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Job Cost Module 

 

May 2022 ALERE® Version 17.0 

 

 A new Job Costing module was added to the product. The ALERE Job Cost module provides a 

structure that allows the accumulation of costs associated with a complete job. These costs may include 

expenditures acquired from purchase orders, service tickets, and work orders. The cost data is collected 

for material, labor, and overhead and can be compared to budgeted amounts. 

The ALERE Job Cost module can group purchase orders, service tickets, and work orders to provide 

summary costs for a job.  

 

On the default ALERE ribbon, the ALERE Job Cost module screens and reports are located on the 

Manager tab. There are three primary screens in the module. They include the Time Clock screen, the 

Job Master screen, and the Job Quotes screen. 

Jobs are identified with a unique ten-character Job ID. The Job Master screen is used to define the job 

characteristics, including the job description, team leader, customer, associated Sales Order (optional), 

and other miscellaneous data. 
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Budgets can be established for each job. These budgeted values can be compared to projected and 

actual costs. Completion percentages can be computed for the entire job. 

 

Purchase Orders, Service Tickets, and Work Orders can be linked to a Job by entering the Job ID on 

each order document. Alternately, the Job Master screen Orders tab can be used to establish the link for 

each order. This allows extra flexibility in the way a job is defined.  

 

 

The Job Quotes screen can generate Requests for Quotation (Purchase Quotes) from multiple 

suppliers. The screen can also record the prices quoted in response to RFQs on the original Purchase 

Quote document. Multiple quotes can be compared, and Purchase Orders can be created based on 

selections made by the user.  
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Performance Enhancements 

 

The ALERE Job Time Clock screen allows users to start and stop individual timers. Recorded time can 

be posted to open work orders or service tickets. 

 

There are five reports in the Job Cost module:  Jobs Listing, Job Quotes, Cost to Complete, Job Time 

Analysis and Work in Process. 

 

 

The speed of ALERE, especially the Client/Server version, was improved throughout the product. There 

is also a new Browser Months option on the Company Defaults screen Company tab. This will limit the 

display to only the entered number of months of data in many product browsers. Right-clicking on the Get 

button and then pressing the Search button will still display the entire list for when older data needs to be 

accessed. This will speed up the browsers for companies with large data sets. 
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Accounting New Features 

 

 

Inventory MRP Button - A new MRP button was added on the Location tab of the Inventory Item Master 

screen to bring up the Item MRP Planning screen for that item and location. (Inventory>Item Master) 

 

 

Inventory Label Button - A new Label button was added to the Inventory Item Master screen ID tab to 

print the item’s Lot/Serial Number labels. (Inventory>Item Master) 

Import Header Notes - When importing General Ledger Journal transactions from Excel or a CSV file, 

the Post Note column of the first row can now be used to import Header notes. 
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Detail Button - A new detail button was added to the Sales Order screen Line Items tab next to the 

Available Quantity field. This button will bring up the Item MRP Planning screen for that line item. 

(Sales>Sales Orders) 

 

 

The Future Activity screen can now be used to display items from Shopify. (Inventory>Future Activity) 

Print Communication Log - A new Print button was added to the InTouch Company Profile and 

Prospect Profile screens Contact Log tabs to print the Communication Log for that company and date 

range. 
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Shopify New Features 

 

Preference Button - A new screen preferences interface was added to numerous screens throughout 

ALERE. A new “Pref” button appears on any screen where the various filters, dates, and options entered 

can be saved for that individual user.  

Pressing this button brings up a new Screen Preferences screen with a grid containing all the fields that 

can have their values saved on that particular tab. Any checked entries will be saved when the Save 

button is pressed, and any other options will retain their defaults. Each date that appears in the grid is 

also listed below the grid.  

Dates will not save the current values like other fields but will follow the rule setup in its corresponding 

entry below the grid, allowing for various choices such as the current date, the start of the month, the 

beginning of the year, etc. If the Date + x Days or Date – x Days options are selected, the additional +/- 

Days column will become active to enter the exact number of days to add or subtract from the current 

date. Any saved preferences will automatically be set when the user next invokes that screen. 

 

Cloud Sync Program - The external Cloud Sync program (cldsync.exe) has been updated to support the 

automatic updating of Shopify stores. 

The Shopify interface was expanded to support the upload of item descriptions and images from ALERE 

to Shopify. This uploading process can be automated and supports the synchronization of item 

descriptions, images, stock levels, and product pricing.   
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Manufacturing New Features 

 

 

Mass Picking Screen - A new Mass Picking screen for Work Orders was added to the Order module. 

(Production>Mass Process>Mass Picking) 

 

Add Material - The Add Material to Order (AM) transaction is now available within DAQ. 

Archive WO Material - Work Order material and configurations will now be archived on the Archive 

Orders screen and can be viewed on the View Orders screen. 

Configuration Usage Report - A new Include Archived Orders option was added to the Configuration 

Usage report (Engineering>BOM Reports>Activity> Configuration Usage) 

Exclude Finished Item - A new option to Exclude the Finished Item from the calculations was added to 

the Material Availability report (Engineering>BOM Reports>Control>Material Availability) 

GL Manufacturing Journal Report - A General Ledger Manufacturing Journal report has been added to 

the Work Order module. (Production>Order Reports>Activity>GL Manufacturing Journal) 



8 
 

Service & Mobility New Features 

 

MRP Planning - The Item MRP Planning screen has a new option for Class. If the Item option is not 

entered, a Product Class can be entered to display all items that correspond to that class.            

(Logistics > Review Plan > Item MRP Planning) 

GL Posting in WO - When linked to ALERE Accounting, a new GL Posting tab was added to the Work 

Order screen. (Production>Work Order>Standard) 

 

Automatic Sync Settings - A new Automatic Sync Settings screen has been added to the Mobility 

module. It shows the current automatic sync settings and status. It also allows the user to request an 

immediate sync. (Extensions>Mobility>Auto Sync)  

Bar Codes – A new option to Show Bar Codes was added to the Service Ticket report. (Service>Process 

Reports>Service Ticket) 

Delete Individual Units - Individual Units can now be deleted on Service Tickets if they do not have any 

transactions posted to the unit. (Service>Service Ticket) 

Material Undo - A new Material Undo All Issues (MU) transaction type was added to the Service Ticket 

transactions. (Service>Service Ticket) 

Multiple Material - A new Multiple Material (MM) transaction type was added to the Service Ticket 

transactions. A MM button on the Service Ticket screen Transaction tab invokes the new screen that 

allows posting multiple material issuances or material undo transactions. (Service>Service Ticket) 

Service Dispatch Board - The Service Dispatch Board now has a horizontal scroll bar allowing all the 

service personnel to be seen on the board at once. (Service>Dispatch Board) 

Service Ticket Accept Button - An Accept button was added to the Resources and Results tabs of the 

Service Ticket (Service>Service Ticket) 
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Manager & Miscellaneous New Features 
 

 

Analytics – An Excel Export option was added to the Analytics screens (Customer, Supplier, Inventory, 

and Profit) 

Archive Data - A new option to Remove Company Contact Logs before a defined date was added to the 

Archive Data screen Data Reduction tab. (Extensions>Archive Data) 

Automatic Contact ID – When creating a new company or location, the system will automatically create 

a Contact ID based on the Company ID. 

Company Template – The Company Template screen now allows the definition of a default country for 

the template.  (Manager>Definition>Company Template) 

Generate Labels - A new Active option was added to the Generate Labels screen. 

(Manager>Utilities>Generate Labels) 

Import Companies - The Import button on the Company screen now supports importing additional 

locations to existing companies. (Manager>Company) 

New User Right – added to determine if a user can change the Price/Discount on orders. 

Passwords – The login password length for the ALERE product and DAQ was increased to 16 

characters. 

Reconcile Balances - A new Reconcile Balances function to reconcile the Inventory Tiers with the 

Inventory Quantities was added to the product. (Manager>Utilities>Reconcile Balances) 

Refresh Checking Accounts Balance - A new Refresh button was added to the Checking Accounts 

screen to refresh the balance amount. (Manager>Banking Actions>Checking Accounts) 

Tax Exempt Number and Date – There is now a tax-exempt number and expiration date on the 

customer Ship To tab of the company screen.  This should determine if the order is tax-exempt or not 

when creating an order. 
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The browser Search function - now allows an In List option choice for both search criteria; such as 

searching for an order Status of A, S, or P.  

 

Non-Transactional Data - The Add New Company screen has a new checkbox to copy just the Non-

Transactional Data from the Import Companies when adding a new ALERE company. This will bring over 

all the static type data such as Customers, Suppliers, Inventory, GL Accounts, etc. but none of the 

transactional data such as Orders, Logs, etc. (File>Open Company) 
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Email New Features 

New Reports and Report Options 

 

1099 Amount and Forms - A new 1099 Amount field was added to the AP/Cash Payments screen to 

allow the editing of the 1099 amount for a check that has been posted. (Purchases>AP/Cash Payments)  

Also, electronic filing has been updated to allow combined federal/state filing for 1099 NEC. 

Call Activity Report - A new Call Activity report was added to the system. This report displays and can 

be ordered by the Next or Last Call/Contact dates. (InTouch>Activity Reports>Call Activity) 

DAQ Scripts Report - The DAQ Scripts report has a new option to Include Accounting Only, 

Manufacturing Only, or All scripts. (Manager>Control Reports>DAQ Scripts) 

GL Journal Report - A new option to Show Entire Journal Entries was added to the General Ledger 

Journal report. This option will show the entire posting that contains the filtered conditions rather than just 

the specific lines of those postings. (Finance>Financial Reports>Journal) 

Income Statement Report - The Income Statement report has a new Zero Balances option choice of 

Exclude Zero Net. (Finance>Reports>Financial>Income Statement) 

Inventory Issues & Receipts Report - A new Company ID option was added to the Inventory Issues & 

Receipts report. (Inventory>Activity Reports>Issues & Receipts) 

Open Orders Sales Report - A new Order By option choice for Product Class was added to the Open 

Orders (Sales) report. (Sales>Control Reports> Open Orders (Sales)) 

PO Receipts Report - A new Net Out Receipts by Date option was added to the Purchase Order 

Receipts report. This option will combine any reversed receipts with the receipts for that date. 

(Purchases>Activity Reports>Purchase Order Receipts) 

Sales Analysis Report - A new version of the Sales Analysis report was added to the Analytics module 

that can include the archived data. (Extensions>Analytics>Reports>Sales Analysis) 

Unrecognized Payables Report - A new option choice of Only was added to the Include Purchase 

Variance option on the Unrecognized Payables report. (Purchases>Control Reports>Unrecognized 

Payables) 

 

Mass Email/Mail List - The Mass Email/Mail List Rules and Mass Email/Mail List screens now support 

additional options for Purchased Item(s) and/or Purchased Product Classes across a date range. 

New Email rule – on Cash Receipts, specifically on usage of credit cards & cash payments. 

Prepayment Email Rule – You can set an email rule to send an internal email when an SO prepayment 

is posted on an SO. 

Service Ticket Email Rule - A new Email Automation rule was added to allow an email to be sent to the 

customer, an internal person, or the service technician when a Service Ticket is dispatched. Note that the 

subject and body text of a dispatch type email will support |12| for the dispatch date and |13| for the 

dispatch time in a 24-hour format. (Manager>Codes & Rules>Email Automation Rules). 

UPS Tracking Number - on the Packing list and AR emails, now hyperlink to the UPS tracking site. 
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New Permissions 

 

JMJM = Job Master 

JMQU = Job Quotes 

JMTC = Time Clock 

JRCC = Cost to Complete Report 

JRJB = Jobs Report 

JRQU = Job Quotes Report 

JRTA = Time Analysis Report 

JRWP = Work in Process Report    

KRCA = Call Activity Report 

OFQI = Increase WO quantity with IP   

SFCP = Change Price/Discount on Orders 

WSAS = Automatic Sync Settings 
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